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Safety Warnings and Guidelines

1. Besureto carefully follow provided machine assembly instructions before machine use to ensure operator
safety.

2. Allwires must be appropriately positioned before beginning the operation of this machine. Cutting a “live”

wire may cause exposed metal parts of the routing/trimming tool to become electrified and shock the

operator.

Ensure the machine is placed on a flat surface and in a well-ventilated space before operation.

Always wear eye protection during machine operation.

Always wear hearing protection during extended machine operation based on proximity to machine.

Materials may release chemicals that are toxic or unsafe to inhale when cut. Always check the Material Safety

Data Sheet (MSDS) of the material in question before cutting. Always cover exposed skin and wear

appropriate airway protection (e.g. dust mask/respirator) specific to the material used and its application.

7. Anyworkpiece must be appropriately secured before starting a cutting routine by clamps or other practical
securing method. Holding the material by hand or employing any other unstable form of securing will lead to
unsafe loss of machine control.

8. Cutting bits used for the Mill One should be used at the discretion of the user. Bits are sharp and can crack
and break without notice so appropriate care should be taken by the user while manipulating and installing
them. Carefully check bits for cracks or damage before operating the machine and replace any cracked or
unfit bits immediately.

I

9. Carefully inspect any consumable material before use on the machine, any unforeseen inconsistency in
material hardness or material quality may cause damage to the machine.

10. Keep away from all moving parts during machine operation.

11. Before beginning a cutting job, ensure the router/trimmer runs properly. Immediately disable the tool if
visible vibration or wobble occurs. This might indicate a damaged tool or an improperly installed bit.

12. Make sure the bit in not contacting the workpiece before the router/trimmer tool is turned on.

13. Do not leave the machine running unattended, the machine should only be operated with the operator
present.

14. Do not touch the cutting bit immediately after use. It may be hot and could burn the operator.

15. Use bits that are appropriate to the material and cutting speed used.

Machine Disclaimer

The product user takes on all the associated liability pertaining to the operation and performance of the Mill One. The listed
“Safety Warnings and Guidelines” outline the necessary precautions that should be taken any time the machine is operated.
Sienci Labs will not be held responsible for any damages to property or injury incurred on the operator or bystanders. Sienci
Labs will not be held responsible for damages to property or injury incurred on the operator or bystanders if any alterations are
made to the design or assembly of our machine. Although care is taken to ensure the accuracy of information made available on
this website and other forms of media, Sienci Labs will not be held liable for inaccuracies, errors, or inconsistencies in website
content, the content of files linked to by this website, references made to external websites herein, and/or information
produced by Sienci Labs. The information which has been made available will not be applicable to all situations and is subject to
change without notice so it should not substitute for the discretion of product users. Variability in machine accuracy and
performance may occur due to improper machine assembly by the user, as such, Sienci Labs takes on no responsibility for
variation between claimed machine specifications and the performance of the user’s machine from improper assembly.

SIENCI LABS

DESKTOP CNC MILLING



LIST OF

M3-N M3-8 M3-15 M5-N M5-NE M5-W M5-25

6Xx 12x 6Xx 10x 6Xx 12x 16x

M8-N
26X

- E-CNC E-C E-HJ E-SDH E-SDC E-W
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STEP 1
Lead S qp — o
Neuat H<§|rdei\r/1vg @ — ot

Assembly P-NH AN M3-15 M3-N 2.5

3x 3x 6Xx 6x Allen

Take note that one of the three plastic nut holders
(P-NH) is a different colour and is not the same as
the one depicted. It’s still assembled the same way
but is specially used for Step 2.

DESKTOP CNC MILLING

See: “Assembling the Mill One Gantries” -> 1:10 - 2:10 SIENCI LABS
https://www.youtube.com/watch?v=_yZ2KRg6oNM&t=1m10s




STEP 2

XZ Gantry /

@,
Assembly 1= e
G-XZ M5-25 M5-N 4
1x 2x 2x Allen

This is the mirrored lead screw nut assembly.

Check that the M5 nuts are properly fitting into

the nut traps.
See: “Assembling the Mill One Gantries” -> 2:10 - 3:05 SIENCI LABS

https://www.youtube.com/watch?v=_yZ2KRg6oNM&t=2m10s

H
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STEP 3

Y Gantry
Assembly

G-Y
1x

Allen

See: “Assembling the Mill One Gantries” -> 3:05 - 4:02

https://www.youtube.com/watch?v=_yZ2KRg6oNMé&t=3mb5s
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STEP 4

XZ Gantry Q
Assembly e
4 10mm
Allen Wrench

Match the eccentric nuts (M5-NE) to the larger
holes, and the regular nuts (M5-N) to the smaller
holes

See: “Assembling the Mill One Gantries” -> 4:02 - 6:52 SIENCI LABS
https.//www.youtube.com/watch?v=_yZ2KRg6oNM&t=4m2s DESKTOP CNC MILLING




STEP 5

XZ Gantry & @ ) Q
Assembly
VB M5-25 M5-W M5-N M5-NE 4 10mm
4x 4x 4x 2x 2% Allen Wrench

Match the eccentric nuts (M5-NE) to the larger
holes, and the regular nuts (M5-N) to the smaller
holes

See: “Assembling the Mill One Gantries” -> 4:02 - 6:52 SIENCI LABS
https://www.youtube.com/watch?v=_yZ2KRg6oNM&t=4m2s DESKTOP CNCMILLING




STEP 6

Y Gantry & @ ) Q
Assembly
VB M5-25 M5-W M5-N M5-NE 4 10mm
4x 4x 4x 2x 2% Allen Wrench

Match the eccentric nuts (M5-NE) to the larger
holes, and the regular nuts (M5-N) to the smaller
holes

See: “Assembling the Mill One Gantries” -> 6:52-7:56 SIENCI LABS
https://www.youtube.com/watch?v=_yZ2KRg6oNM&t=6m52s DESKTOP CNC MILLING




STEP 7

Mounting the
Motors to the
Rails

P-AM M3-8 25
3x 3x 12x Allen

Make sure that the motor connector is facing
downwards

See: “Assembling the Mill One Gantries” -> 7:56 - 9:03 SIENCI LABS
https://www.youtube.com/watch?v=_yZ2KRg6oNM&t=7m5és
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STEP 8

orge & S o

Rails

>
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X 8
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1x 6X Allen

See: “Assembling the Mill One Gantries” -> 9:03 - 9:47 SIENCI LABS
https://www.youtube.com/watch?v=_yZ2KRg6oNMé&t=9m3s
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Allen

Q)
wn

1x

1x

STEP 9

Attaching

X-Lead Screw

to XZ Gantry

Make sure to push coupler all the way onto lead

screw before tightening

SIENCI LABS
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=13m

yZ2KRg6o0NM&t

See: “Assembling the Mill One Gantries” -> 13:00 - 13:21

https://www.youtube.com/watch?v




STEP 10

Attaching the o Q

X-Rail to the XZ

Gantry ) 10mm
Allen Wrench

Rotate the eccentric nuts (M5-NE)
until gantry slides onto the rail easily

Make sure to push coupler all the way onto
motor shaft before tightening

See: “Assembling the Mill One Gantries” -> 13:21 - 14:08 SIENCI LABS
https.//www.youtube.com/watch?v=_yZ2KRg6oNM&t=13m21s DESKTOP CNC MILLING




STEP 1

Attaching the
X-Rail to the XZ
Gantry

% e 2

M8-15 6 10mm
Allen Wrench

Rotate the eccentric nuts (M5-NE) to
tighten the grip of the wheels on the
rail. Tighten until you can no longer
rotate the V Groove bearings (VB) with
your fingers.

See: “Assembling the Mill One Gantries” -> 9:47 - 10:39 @ SIENCI LABS
https.//www.youtube.com/watch?v=_yZ2KRgé6oNM&t=9m47s DESKTOP CNCMILLING




STEP 12

Attaching N

Z-Lead Screw Q o

to XZ Gantry 15-200 sc )
1x 1x Allen

Make sure to push coupler all the way onto lead
screw before tightening

See: “Assembling the Mill One Gantries” -> 11:03 - 12:07 @ SIENCI LABS
https.//www.youtube.com/watch?v=_yZ2KRg6oNMé&t=11m3s DESKTOP CNCMILLING




STEP 13

Attaching the Q
Z-Rail to the XZ o

ntr
Gant 14 2 10mm
Allen Wrench

Rotate the eccentric nuts (M5-NE)
until gantry slides onto the rail easily

Make sure to push coupler all the way onto
motor shaft before tightening

See: “Assembling the Mill One Gantries” -> 12:07 - 13:00 @ SIENCI LABS
https.//www.youtube.com/watch?v=_yZ2KRgé6oNMé&t=12m7s DESKTOP CNCMILLING




STEP 14

Calibrating the Q

V Groove
Bearings on

10
the XZ Gantry Wr;?]r:h

Rotate the eccentric nuts (M5-NE) to
tighten the grip of the wheels on the rail.
Tighten until you can no longer rotate
the V Groove bearings (VB) with your

fingers.
See: “Assembling the Mill One Gantries” -> 9:47 - 10:39 @ SIENCI LABS
https.//www.youtube.com/watch?v=_yZ2KRg6oNM&t=9m47s DESKTOP CNCMILLING




Allen

O
n

1x

1x

STEP 15

Attaching Lead
ScrewtoY
Gantry

Make sure to push coupler all the way onto lead

screw before tightening

SIENCI LABS
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14m8s

yZ2KRg6o0NM&t

See: “Assembling the Mill One Gantries” -> 14:08 - 14:25

https://www.youtube.com/watch?v




STEP 16

Attaching the o Q

Y-Railtothe Y

Gantry ) 10mm
Allen Wrench

Rotate the eccentric nuts (M5-NE)
until gantry slides onto the rail easily

Make sure to push coupler all the way onto
motor shaft before tightening

See: “Assembling the Mill One Gantries” -> 14:25 - 15:09 @ SIENCI LABS
https.//www.youtube.com/watch?v=_yZ2KRg6oNMé&t=14m25s DESKTOP CNCMILLING




STEP 17

Attaching the
Y-Railtothe Y
Gantry

% e 2

M8-15 6 10mm
Allen Wrench

Rotate the eccentric nuts (M5-NE) to
tighten the grip of the wheels on the rail.
Tighten until you can no longer rotate
the V Groove bearings (VB) with your
fingers.

See: “Assembling the Mill One Gantries” -> 15:09 - 15:25 @ SIENCI LABS
https.//www.youtube.com/watch?v=_yZ2KRg6oNMé&t=15m9s DESKTOP CNCMILLING




STEP 18

Attaching the
Router Mount

2X 2X Allen

The bottom of the mount (P-RM) should be the side
that is more flush with the bottom of the aluminum
rail (AR-200)

See: “Assembling the Mill One Gantries” -> 15:25 - 15:53 SIENCI LABS
https.//www.youtube.com/watch?v=_yZ2KRg6oNMé&t=15m25s DESKTOP CNC MILLING




STEP 19

AttachingY 9 .

Gantry to

Frame F-B F-F M8-25 M8-N 6
1x 1x 4x 4x Allen

See: “Assembling the Mill One Frame” -> 0:46 - 2:05 SIENCI LABS
https://www.youtube.com/watch?v=rzGFd-v3d30&t=46s DESKTOP CNCMILLING




STEP 20
Attaching XZ 9
Gantry to — .
Frame F-L F-R M8-25 M8-N 6

1x 1x 4x 4x Allen

L

See: “Assembling the Mill One Frame” -> 2:05 - 3:06 @ SIENCI LABS
https://www.youtube.com/watch?v=rzGFd-v3d30&t=2m4s DESKTOP CNCMILLING




STEP 21

Attaching the
Assemblies

See: “Assembling the Mill One Frame” -> 3:06 - 3:14 SIENCI LABS
https://www.youtube.com/watch?v=rzGFd-v3d30&t=3més DESKTOP CNCMILLING




STEP 22

Attaching

Frame Brackets

gﬂd ﬁjcryllc F-AC P-FB
€ 1x 4x

M8-25
16x

& o
M8-N 6
16X Allen

S

M s
\\\\\\\\\
M
SH

\\\\\\\\

@\ @\ ii

Twist on nuts and bolts on all corners loosely,
then tighten on a flat surface

See: “Assembling the Mill One Frame” -> 3:14 - 3:52
https.//www.youtube.com/watch?v=rzGFd-v3d30&t=3m14s

H
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STEP 23

Combining the
Arduino and
CNC Shield

See: “Wiring the Mill One’s Electronics” -> 0:16 - 1:40 SIENCI LABS
https.//www.youtube.com/watch?v=wYr3DWGXiFc&t=16s DESKTOP CNC MILLING




STEP 24

Attaching the
Header
Jumpers

E-HJ
6X

See: “Wiring the Mill One’s Electronics” -> 1:40 - 1:56
https://www.youtube.com/watch?v=wYr3DWGXiFc&t=1m40s

H

SIENCI LABS
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E-C
3x

Motor Cables

Attaching

STEP 25

Make sure the black wire is oriented as depicted

SIENCI LABS

DESKTOP CNC MILLING
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Im5és

See: “Wiring the Mill One’s Electronics” -> 1:56 - 2:30
=wYr3DWGXiFc&t

https://www.youtube.com/watch?v




Stepper Driver

STEP 26
Attaching
Chips

SIENCI LABS

DESKTOP CNC MILLING

H

2m30s

See: “Wiring the Mill One’s Electronics” -> 2:30 - 3:38
=wYr3DWGXiFc&t

https://www.youtube.com/watch?v




STEP 27

Tuning the +

Stepper Motor

Drivers Phillips

The stepper drivers should be tuned using the
) potentiometer on the front so that the flat
20 edge on the dial faces to the left; this gives
the stepper motors on the Mill One the right
amount of power to run effectively. If further
tuning is required, turning the flat either

counterclockwise or clockwise will increase
or decrease the motor power respectively.

&

Stepper driver potentiometers should never
be turned while the board is powered up

See: “Wiring the Mill One’s Electronics” -> 3:38 - 4:14 SIENCI LABS
https://www.youtube.com/watch?v=wYr3DWGXiFc&t=3m38s DESKTOP CNCMILLING




Phillips

> x

w N
) 2
N mbMe
a £+ 2.
w $82%8
= £S08
v <2034

Ensure polarity is correct to avoid damage to

electronics

SIENCI LABS
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H

4dm14s

See: “Wiring the Mill One’s Electronics” -> 4:14 - 5:19
=wYr3DWGXiFc&t

https.//www.youtube.com/watch?v




Placing Boards
into Electronics

STEP 29
Holder

SIENCI LABS

DESKTOP CNC MILLING

H

5m19s

See: “Wiring the Mill One’s Electronics” -> 5:19 - 5:52
=wYr3DWGXiFc&t

https.//www.youtube.com/watch?v




Phillips

5

-

o

E-J
1x

by

R

5

Feeding Wires
Through Slots
+ Attaching DC
Jack

STEP 30

Ensure polarity is correct to avoid damage to

electronics

SIENCI LABS
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H

5m52s

See: “Wiring the Mill One’s Electronics” -> 5:52 - 8:03
=wYr3DWGXiFc&t

https.//www.youtube.com/watch?v




£

P-PH
1x

STEP 31

Securing the
DC Jack

Some machines may not need this step as the DC

Jack (E-J) should fit snugly

SIENCI LABS

DESKTOP CNC MILLING

H

8mO03s

See: “Wiring the Mill One’s Electronics” -> 8:03 - 8:38
=wYr3DWGXiFc&t

https://www.youtube.com/watch?v




STEP 32

Attaching
Electronics to
Motors

D 9
o )
9 9

&

See: “Wiring the Mill One’s Electronics” -> 8:38 - 9:08 SIENCI LABS
https://www.youtube.com/watch?v=wYr3DWGXiFc&t=8m38s DESKTOP CNCMILLING




STEP 33

Assembled
Mill One

Your Mill One is now fully assembled. Don’t plug in your power brick yet, simply
connect the USB cable to your computer and continue onto the next steps.

See: “Wiring the Mill One’s Electronics” -> 10:47 - 10:57 SIENCI| LABS
https://www.youtube.com/watch?v=wYr3DWGXiFc&t=10m47s DESKTOP CNCMILLING




INSTALLING
FIRMWARE

SIENCI LABS

ORDER NOW

BLOG

ABOUT

CONTACT

=0 ITEMS - §0.00

PUT CNC ON YOUR DESKTOP

WVISIT OUR BLOG

ORDER HOW

Open your favourite web browser and navigate to the Resources tab of our website.

SIENCI LABS

Resources

Hardware:

Software:

i com

Sienci Mill One Facebook Group

Like what we're doing?

Bend us a

do

nation and help grow this project

Nnnata

uuuuuuuuu

On the Resources page, under the Software heading, you should notice a link to the Firmware.

H

SIENCI LABS

DESKTOP CNC MILLING




N ] sinncicem . o

Sl Wi Dine Fymwans | BENCI LABS.

ORDER NOW BLOG RESOURCES ABOUT CONTACT =0 ITEMS - $0.00

SIENCI LABS

Ideas imo Reality

Sienci Mill One Firmware

The Siancd Mill One uses Ot firmware on an Arduing Uno. The firmware can be flashed ontg the
Arduing Una with the Ard ith default satting i () , and by
following the Instructions an the Grbl w This version ks meant for Mill Ones set up for 1/8

microstepping
Pleage note that Grbl 1.1v works best with the katest nightly bullds of

If you are using an Apple compiter with the latest 05 (10.12 Sierra), you may experiance crashes

when plugging In CH340 based Arduina Linos. Please use this dgver if you have trouble connesting

(e
your Arduing to your computer or if you experience these issues. Windows users shauld not have this

lam.

‘o e @ codeiord garub com o

ST I A 0G-E N4 -Ch I n-mic-08-r-rrves: CHIG0G C

(9] . Pull reuasts  Issues  Gist +- @-

5 CIIAK Mac G5 X ariver +

ihalko | ch340g-ch34g-ch3dx-mac-os-x-driver @ Waich+ 18 s Star 183 ¥ Fork 1o

€3 Code il v

CHA40G CHIAG CHIAX Mac OF X driver

master = New pull requst Crosterewfile  Upioad thes  Findtile  EEeRREESE SRRy

[ sdrianminalis commirted on GitHub W

53 README md

ch340g-ch34g-ch34x-mac-os-x-driver

Latest macQS Slerra-compatible driver for devices using the CH340G, CH345 or CH34X chipset. This chipset is. used in
several Arduino-clones.

Introduction

If you're using an apple product, your first step will be to download the driver linked on the page.
This will ensure that plugging in your Arduino doesn’t cause any issues.

SIENCI LABS
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89 ch3a0g-ch3ag-ch3dusmac-os-x-driver-mastar
¢ '.'.Hii::l_-.’ Wy &

ERIADG- eI £ 0D e -k £ vw- TR R

~  Dube Modiied

Firvnrites S

£ DonDonDenz0

B3 #hotos Ocx 38,2
B Desktop README md Oct 1
5 Boogie tiive « ReadMe.pot Q51 18, 2078, 370 FM
T psic
B a8 vy e
o Pictores
[ Deocuments
0 Downloogs
() Remote isc
L sech a
Sharmc
B inielc S o B oo s B cn3a0g-chisg-chiin-mar-om-a-driver-master 1
1 of & asivctod, 18 49 GA availsbie
w0 Imstall CH 34 Install
Installing CH3Ax install
» Introduction
= Destination Select s
o Instadiation Typa
» Instaliation q 19 Uf f S,

ins1all time remaining: Less than a minute

W CH3dx_irssall V130kg

* s 8 0

e Install CH3Ax install SRR —

Welcome fo the CH34x nstall Installer

Walcomna 1o CHI41 and CHI40 usb 1o sarial device driver

Intreduction
Destination Select
Instaliatian Typa
Instadiation
Summary

This program instal the driver 10 the delaLn direciary o the systm ,
@0 mot change it
Also thia installabon only support CH341 and CHO40 |

T Inwtall EH 34 nstall s

The was Y.

@

The installation was successful.

The software was installed,

‘Click Restart to finish installing the seftware.

e

Once you run the package in the downloaded folder, the driver will install. You will be prompted
to restart your computer, once the restart has completed, you should return to the Firmware

page of our website

SIENCI LABS
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N sienci.com (4]

SlENCl LABS ORDER NOW BLOG RESOURCES ABOUT COMTACT = 0 ITEMS - $0.00

Sienci Mill One Firmware

The Sianci Mill One uses Cr firrmware on an Arduing Una. The firmware can ba flashed onto the
Arduing Une with the duiin WD cetaull setl the s 1M <. and by
fellowing the instructions on the Gt i g This versian is meant for Mill Ones set up for 1/8

milcrostepping.
Please note that Gril 1, 1v warks best with the tatest nightly builds of Lin)

f you are using an Appie computer with the latest OS (10.12 Sierra), you may experience crashes
when plugging in CHI40 based Arduino Unos. Please use this drver if you have trouble connecting
your Ardulng to your computer or if you experience these issues. Windows users should not have this

probiem

Back on the Firmware page, you'll want to click to download the “Grbl 1.1v with default settings
for the Sienci Mill One” firmware.

(S arduinc.ang = L]

Desminad 1ha rigine Arduna saftaee |

ARDUINO

0 0 ® 0O

Arduino provides an open-source and easy-to
eSS PO ARDUINO v

Arduino IDE {Integrated Deve Bt t | D E &
i +

If you ure new to Arduino

Warning Java 8 with t

You'll also want to download the latest Arduino IDE onto your computer; select your operating
system to download the appropriate package.

SIENCI LABS
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= i ard

ARDUINO

ownload

0 00 0

with the

Arduine provides an open-source and easy-to
use programming tool, fo
ioedin

Arduing IDE [inte

Preparing boards...,
Warning: Use java 8
i .
= f
&) D), @
SOURCECODE

PREVIOUS RELEASES

Open the Arduino IDE once it’s insta

New N
Oy
Ogetrt Recent [
Sketchbook *
Examples 3
Clase EW
ARD|  Saw #s
Save As... Tus

Pape Setun 0P
Print ®p

0000

Program your hardy

uino

Ardulne provides an open-source and easy-1

use programming bool,
Arduing 1DE (In

If you are new to Arduino =

Warning: Use java B v

5

PREVIOUS RELEASES

Once open, navigate to File-> Open

uino.org

Wiielvi-) k

Cenuino

ARDUIND

lled

4

andiing ang

Skench,_jan23a | Arduino 1.8.1

SOURCECOOE

T 40 SINEE M MoniZBAM Andyles O M

CHANCELOG
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m < w =[E) m-  Bmoownicads $ il -
Firvorioas & arduino I GRBL v1.1 SLne Fiemwara  * [0 grbt . canfig B coskiap. B doskiop
= DonDenDoniD B8 ch34aog-ch3. driver-master * B UniversalGe _er 2.0 Nightty  » grolz eoalant_contr B groiuplosa --""I"!:'l._
= at | ORBL-v1 " et cont B grbiWrite_Bulldinto » ansPi
[ Desktop ol 5iills ue
53 Google Drive i
7 musie B e
B MMy Files
B Pietures [0 examples L4
% Docurnents : 4
© Downicads
Davices
Remate Oisc
|2 ssca 8
Shared
B intot_ce_Snu
Tags
MNew Folde Cancel

You should find a folder for the GRBL download in your downloads folder. Navigate through the
folders until you find grblUpload.ino, double-click it to openiit.

AN 0rg
ARDUINO
Download
L] prhilpiosd | Arduing 1.8.1
0000 aid
ut 1
og L
L au LLIC b 1 4
Arduino provides an open-source and easy-{ | -
use programming tool, for writing coce and
phaading It 1o your b e
Arduino IDE (Integrat
If you are new to Arduino i
all Arudif .

52 java B with the new Arduing |DE!

Warning:

SOURCECODE CHANCELOC

This is the code that needs to be uploaded to the Arduino.

SIENCI LABS
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& Ardulno Fie Edit JEITIENN Tools  Help O3~ % ]
Verify/Cample =1 Ry
Upiaad ®U
Upload Using Programmer €30 owtinnd the angns Ao softwary
Export compiled Binary TES
Show Sketch Folder oK

ARDUINO

Add File...
DownToad

prbiUpinad | Arduing 18,1

0 0@¢eo

Robot Controd "
Raobat IR Remate
Arduino provides an open-source and easy:

use programming tool
i riaring T ko e Tachs &
Apiuie " Spacebrewiun
If you are new v Temboo e
art we have pre vit  Wire
tall Aruig E e

‘Adafreit Circalt Playground

Warning: Usa Java 8 with the new Arduino 108

Fmy

ey

l‘""‘_}l)

. "5

PREVIOUS RELEASES SOURCECO0E CHANGELOG

Robat Mator L o e
5D

T o) NI M MonTISAM Andylee O @ =

The last step to prepare for uploading the code is to include the Grbl library. Go to Sketch->
Install Library-> Add .zip Library then navigate back to your downloads folder.

0 £ n= E 2.+  [B bownloads &

Favarites € Arduino =9 GRBL ¥1.1 SL.ne Firmware »
5 DonDonDon3D 8 ch340g-ch3.. driver-master * [ UniversalGe..er 2.0 Nightly »
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Once again, open the Grbl folder then navigate through and double-click on the grbl.zip file.
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The Arduino IDE should confirm that the Library was added and you will now be able to upload
the code to the Arduino.
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Check in the Tools tab that you've selected your board to be the Arduino Uno.
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Also check that the proper port is selected.
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Then click Upload on the IDE to upload the code.
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The IDE should confirm that the code is done uploading.
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To confirm that the code was implemented correctly, go to Tools then open up the Serial Monitor.
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Once you set your baud rate to 115200 you should see that the monitor shows the following
message, this means that the firmware has been uploaded correctly.

Congratulations!

Your Mill One should now be ready to go. In order to start using your machine you should start
becoming comfortable with a CAM software as well as find a program which will send the g-code
to your machine. For our software recommendations, you can navigate back to the Software
heading on the Resources page of our website. For additional resources, be sure to check out our
other hardware resources as well as request to join our user Facebook group where you can ask
guestions, find answers, and interact with the rest of the Sienci community.
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